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Purpose
The main purpose of this guide is to cover every aspect of the fixture diary system, to inform the user of
how to use each and every element of the system.
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Frequently Asked Questions
What is the purpose of the system?
The system has been developed to replace the old paper‐based diary system. It is an online system,
meaning that the system is accessed via the Internet. The system displays all of the planned fixtures for the
girls’ PE department and a range of searches can be performed on the fixtures. There is also the option for
some users to add and delete fixtures from the system.

Where can the system be used?
It can be used anywhere where there is an active Internet connection. This could be within school on the
networked computers, or at home on a laptop or desktop computer connected to the Internet. If you have
Internet connectivity on a mobile device such as a phone or tablet computer, it can be also used there too!

Who is the system designed for?
It is mainly designed for use by the PE department, but is also accessible to pupils, parents and any other
visitor who may be interested in the PE department and their arranged fixtures.

What stops unauthorised user from accessing the secure areas?
There is a password protected area, where users need a valid username and password to access aspects
such as the advanced search facility, adding new fixtures and deleting fixtures.

Getting Started
Accessing the system:
From any computer/device connected to the Internet:
1. Select Internet Explorer or an alternative Web browser e.g. Opera, Firefox, Chrome or Safari
2. Type the following address into the browser: www.combeabbeype.co.uk
3. This will open the home page for the PE Department System:
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From here, you can access any page within the fixtures diary system, using the underlined links.

Navigation
To navigate within the site, you can use the main links at the top of each page.

Every page within the site has been designed using the same layout, to try and make the system easy to use
and for you to find the information you are looking for.

Exiting the system
To exit the system, simply press the red ‘X’ usually located on the top right hand corner of your Internet
browser. On a Mac, you may find the ‘X’ is on the top left corner of your browser.

Public Access Pages
There are a number of pages within the fixtures diary system, which have been developed for public access.
This means that staff, pupils, parents and anyone who has an interested in the PE department’s fixtures can
view these pages, which are described below:

Home Page
The home page, shown earlier provides users with a brief overview of what the site is for and what users
can actually find within the site. It is an introduction for any visitor.

Club Information
The club information page provides visitors with information about the different clubs that are run within
the school. The timings are provided for each club and which year group it is for.
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PE Department
The department page provides visitors with a list of department members. It also lists the teams each
member is in charge of and also provides a little information into the sporting background of each teacher.

Fixture Search
The fixture search
page is one of the first
pages, which is linked
to the actual fixture
diary system. From
here, any user can
simply select a sport, a
year group and then
click the submit
button. A search is
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then performed on the diary and the relevant results matching the search criteria are displayed for the
user. The results will not always be the same as shown, as fixtures are regularly added, edited and deleted.

An example of a search and results is
shown here for year 7 athletics. The
number of results is displayed and the
search criteria used is confirmed at the
end of the search.

Fixture List
The fixture list page is also one that
connects to the fixture diary system. It
displays the user with a list of all
fixtures and they are split between two
tables. The top table displays all
fixtures that are to be played on
today’s date or later. The lower table
displays all fixtures that took place
before today’s date. The page results
will not always look like the example below, as data will be added, edited and deleted from the diary
system.
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Restricted Access Pages
There are a number of pages within the diary system, where access is restricted to staff only visitors. These
areas are clearly identified and are accessible via the Staff Login link at the top of each page. If you do not
know your username and password for the restricted access areas, please see the school technicians, who
will be able to provide you with them.

Staff Login
To access any of the staff only pages, you need to first click on the Staff Login page. From here you will be
able to enter your username and password and therefore access the add fixture page, delete fixture page
and advanced search page.

When you have entered your username and password, click on the Log in button and you will be logged
into the system and this will be confirmed, as seen below:

10

Adding a Fixture
To create a new fixture to the diary, click on the ‘Create New Fixture’ link on the login page. You will be
taken to the screen below:

From this page you can add a fixture to the online diary system and it will be displayed in searches that are
performed by visitors to the site or logged in staff members. The form is simple to use, but an explanation
of what to enter into each field is provided below:
Field Name

What to Enter?

Sample Data
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Sport
Date
Time of Day
Venue
Lead Staff Member
Assistant Staff Member
Year Group(s)
Event
Time
Transport Booked?
Packed Lunch?
Team Size

Select a sport from the drop down list
Enter the date of the fixture in the format
yyyy/mm/dd
This is roughly when the event is taking place
and selected from a drop down list
This is where the fixture is taking place
This is who the staff member in charge is
This is the name of any support staff
Tick the year groups that will be attending the
fixture
The name of the event taking place
The time the fixture is taking place
If transport has been booked, tick the box
If a packed lunch is required, tick the box
This is the approximate team size for info.

Swimming
2012/11/21
Evening
City Pool
J Wheel
None
Year 7 – Tick
Year 8 – No Tick
Tyne and Wear Gala
16:00
Tick = Yes
No Tick = No
25

Fixture Confirmation
Once the data has been entered into the fixture entry page and the submit button has been pressed, a
confirmation page is displayed, which displays the data that has now been added to the fixtures diary. If
you wish to cancel a fixture entry, don’t click the submit button; instead press reset and the fixture
information will be cleared from the form:

From this page, you now have the option to: add another fixture, search for a fixture or log out of the staff
only area. You also have the main links to choose from at the top of the page.
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Deleting a Fixture
There may be a time when you need to delete a fixture: either it has been added in error via the fixture
entry form, or the fixture has been cancelled due to bad weather or the opposition team cancelling for
example. The delete page is simple to use and is again only accessible to staff members who are logged in,
so there is no worry of a pupil deleting fixtures for you! If you change your mind and don’t want to delete a
fixture, you can access the other pages, via the links at the bottom of this page.
The delete fixture page is accessible via the Staff Login page and when selected, displays you with a list of
all fixtures within the diary system, in date order. All you have to do is look for the fixture you want to
remove and then find the corresponding ID number from the first column.
For this example, the fixture with the ID number 37 will be deleted, as it has been added in error. You
simply type the ID number in the text box at the bottom of the page and then click ‘Delete Fixture’.
WARNING: this action is not reversible and the fixture will be deleted when the button is pressed!
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Fixture Deletion Confirmation
Once the delete button is clicked, you are taken to a confirmation page, which displays the fixture number
that you have deleted. Each fixture has a unique ID number assigned to them when they are added to the
fixture diary, so you will only delete the selected record when you use this option. From this page, you can
now access the three staff only pages, all of the public pages, or log out.
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Performing an Advanced Search
Back on the login screen and the other staff only pages, you can access the fixture search page. This runs
the same as the public search page, but there are more search options available and when you see the
search results, there is more data presented.
There are 5 searches on
this page:
1. Year group search
2. Staff search
3. Sport search
4. Sport & year search
5. Custom search
You just find the search
you want to perform,
select the criteria and
press the submit button.
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The only search that is slightly different is the custom search, which we will look at next. For this search,
you can select your search type from a drop down list, but you need to type in the search criteria in the
text box.

For some of the search option, there is an example of how to
enter data, but the table below also provides some guidance.

Search Type
Event Name
Support Staff

Venue
Date
Transport Booked
Lunch Booked

What it Searches For
This searches for all fixtures with the name or part of the
name entered
This searches for all fixtures that have the entered support
staff attending. This must be their forename initial and
surname
This searches for the fixtures with the venue name or part
of the name entered
This searches for all fixtures that match the date entered.
The date must follow the format yyyy‐mm‐dd
This searches for all fixtures that have transport either
booked or not booked. A Yes or No value must be entered
This searches for all fixtures that have lunches either
booked or not booked. A Yes or No value must be entered

Example Search Criteria
ESSA
J Wheel

Gateshead
2012‐11‐21
Yes
No

Please note: Capital letters are not important when carrying out a search, but spelling is. If you are
unsure of a spelling, please try entering only part of the word.

Search Results Pages
Each search page has a separate results page,
with the search type and criteria confirmed at the
bottom of the page. Each page does however
follow the same layout and displays the same
amount of data to the user. An example of a
search result page is displayed and two links are
provided in addition to the main page links: an
option to carry out another search and the option
to log out.
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Logging Out
When you have finished using the secure staff only area, simply select the ‘Log Out’ option on any of the
secure pages and you will be logged out. This will be confirmed via a short message and you will no longer
be able to access the ‘Staff Only’ areas.

An example of the
screen displayed to any
unauthorised user
trying to access the
staff only areas.
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Technical User Guide
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Technical User Guide
Frequently Asked Questions
What is this section of the guide for?
You may find that the fixtures diary needs updating every so often, for example a new staff member joins
the PE team, or a new sport needs to be added to the fixture list. This guide will also explain how to edit a
fixture, which is currently a feature that is not available via the main system, but this will be updated in the
near future.

Who is this section of the guide for?
School ICT technicians and possibly advanced computer users, who has been granted access to the PE
fixtures diary website and database files.

How has the system been developed?
The fixtures diary system has been developed using Microsoft Expression Web 4. The main pages have
been developed via the use of CSS and a dynamic template. There is a backend MySQL database used with
the site, which is connected to using PHP coding on most pages and the database is accessed using
phpMyAdmin.

20

Accessing the Fixtures Database
Using phpMyAdmin
To edit a fixture, staff record or any other aspect of the database, you need to access the backend database
of the fixtures diary, which is via a phpMyAdmin interface. The database is written using MySQL and is very
simple with only two tables, which are not linked.
To access the database, you need to type in the following hyperlink: www.combeabbeype.co.uk/admin and
enter your username and password.
A member of the ICT technical team and for security purposes will give this to you, it cannot be provided
within this user guide.
When you have been granted access, you should be able to see the following menu displayed and you need
to select the option ‘PE(2)’, which will provide access to the two fixtures diary tables.

Select PE(2) and the two tables within the database will be
displayed
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Editing a Fixture
With the two tables visible, you now have a range of options under the title ‘Action’. The option you need
to select to edit a fixture record is the ‘Browse’ option, which is the first one available. If you are unsure,
just hover over each option and its name will be displayed for you.

With this option selected you can view all of the fixtures within the database. To edit a fixture, simply click
on the Pencil tool next to the record you wish to edit:
You can also edit multiple records, by ticking each
record’s box and then selecting the Pencil tool at the
bottom of the table.

You will now be taken to a
data entry form, where all
data for the selected record
will be visible. You just need to
type in the amended data and
when all changes have been
made, click ‘Go’ at the end of
the form.
The alterations will be updated
in the database and a
confirmation message using
MySQL script will be displayed.
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User Management
From the main menu, select the PE option again to display the two tables
and select the ‘users’ table; or if you can see the tables on the left hand
side of the screen, select the ‘users’ table.

Adding a User
To add a user to the table, you will need to use the Insert option, which is
a tabbed option at the top of the page. Select Insert and type in the userid (i.e. the staff member’s
forename initial and first two letters from their surname), password, forename and surname.
The userid is a unique identifier, which means that it cannot be left blank. When the record has been
entered, select ‘Go’ and the record will be added to the table, with a confirmation message displayed.

Changing a Username or Password
To change a user’s details, you need to ‘Browse’ the users table, so that you can see all of the records.
Select the Pencil tool next to the selected user and enter the new details. When alterations have been
made, click Go and the changes will be confirmed.

23

Page Management
You may decide that it is necessary to update the static pages, as they may become out of date or you may
decide that more information needs to be added to them. It is also possible to add new pages to the site
and update the template which pages are based upon. To update the site, open Microsoft Expression Web
and load up the PE Diary Site. The main copy will be stored on the school server, but a backup copy will be
accessible on a USB drive kept in the ICT technician’s office. Any changes made to the pages on the drive,
will then need to be uploaded onto the server, for the site to be updated. Once the site is loaded, it should
look similar to the view below:

Site View

Updating the Page Template
You may want to make changes to the site template. To do this, load up the file Template.dwt. From the
template, any area can be edited including the banner areas and hyperlinks. Make the changes you want to
the template and then go to File – Save to save it.
A message will be displayed asking if you’d like to update the files attached to the template – select ‘Yes’.
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All linked pages will now be updated with the changes that have been made to the template and a message
will be displayed to confirm that this has been done.

Adding a New HTML Page
To create a new HTML page, go to: File – New – Create
from Dynamic Web Template
Select the file called Template and click Open.
Add the required content to the PageContent area and
when you have finished, click: File – Save, giving the page a
suitable name. You will also need to go to File – Properties
and change the page name, using the format:
CA PE Department ‐ *Page Name* Click Ok when finished.

Updating the Page Template Links
Now you have added a new page to the site, you will also need to update the site’s links to provide access
to this new page.
Go back to the template and on the links banner, add the new link name and then direct the hyperlink to
the newly created page. The HTML code will also be updated to show the new page hyperlink.

Save the template and all
pages will be updated with
the new link.
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Updating Static HTML Pages
The static pages that can be edited are: department.html, clubs.html and index.html. You can also add
information to the fixture search page: fixturerscstudent.html.
Double click on the page to be edited and it should open, in a view similar to the one below:
If you cannot see the page and are viewing
HTML code instead, click on the Design tab at
the bottom left hand side of the page.
You can make changes
anywhere within the area
called ‘PageContent’.
You can add any type of content to the page,
whether this is text, images or other types of
media, such as a video, audio recording or
flash animation.

Adding Text: To add text to the page,
simply start typing where you’d like to add
the content. There are three different
formatting options for text style: h1, which is used for main titles,
h2 used for subtitles and body which is used for main page text.
You can change the format of the text via the Manage Styles Tab
on the right hand side of the page. Simply highlight the text you
want to alter and right click on the desired style, selecting ‘Apply
Style’. The style will then be applied to the selected text.

Inserting Images: To insert an
image, go to the Insert menu and
select Picture – From File. Browse
for the image you want to insert
and when prompted, type in
some text which describes the image under the ‘Alternate Text’
option. Click ‘OK’ to insert the image.

Inserting Hyperlinks: If you’d like to add a hyperlink to
another website or page, click an area on the page where you’d
like to insert the hyperlink. Type in some text for the hyperlink text
and highlight it.
Go to the Insert menu and select the Hyperlink option and either select
a place in the document to link to, or
type in a web address, remembering
to add http:// to the start of the
26

address. The link will automatically be formatted for you, to follow the house style.

Altering Dropdown Lists
A final maintenance task that will need to be performed on the pages: fixturesrcstudent.html,
fixturesrcstaff.php and newfixture.php will be the editing of dropdown boxes. This will mainly be to add a
new sport or staff member to the list of options available.
To update the list, you need to open the page and then select the Code view
from the tabbed options at the bottom left of the page:
Scroll down the code until you find the ‘option’ list. The line code starting location for each of the option
blocks is indicated in the table below (please note that values may change after page alteration):
Page Name
fixturesrcstudent.html

Dropdown List
Sport
Year

Field Name
fsearchsport
fsearchyear

Approx. Code Lines
44 to 52
56 to 64

fixturesrcstaff.php

Year Group Search
Sport Search
Custom Search
Staff Search
Sport
Year

fsearchyearonly
fsearchsportonly
fsearchtype
fsearchstaff
fsearchsport
fsearchyear

67 to 75
92 to 100
115 to 123
156 to 163
178 to 186
190 to 198

newfixture.php

Sport
Time of Day
Lead Staff Member
Support Staff member

fsport
ftoday
fstaff1
fstaff2

56 to 64
80 to 85
103 to 111
119 to 127

The main dropdown boxes you will need to edit are for sport and staff. The other searches are linked to the
database structure and should not require editing.
Find the dropdown box code you wish to amend. For the example below, a new sport of Rounders will be
added to the list. After </option>, press return and type in the following: <option>*SPORT*</option>

Save the page and then press F12 to view the page in a Web Browser. The dropdown list should now be
updated.
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Updating the Server Files
When you have made any changes to the site via the backup USB drive copy, you then need to replace all
files on the server. Make sure changes are first checked before an update takes place and that all links still
work as exected.
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Glossary
Criteria
CSS
Database
Dynamic Pages
Field
Form
HTML
Login

MySQL
Password
PHP
phpMyAdmin
Query
Record
Static Pages
Unique Identifier
Username

The rule which is used to filter data when performing a search
Allows web designers to define how a webpage is formatted e.g. fonts and colours
A collection of data which is logically arranged, to be easily and quickly searched
Pages within the site, where content changes depending on search criteria used
A field is a single piece of data about one person or thing
A form is a data entry tool, containing one or more fields, where users can enter data
A coding language used in the development of web pages
To logon means that you need to identify yourself to the system, so that you can gain
access to restricted areas. A common way of logging on is to provide a username and
password that is recognised by the system
A common freely available database system, which is often used for databases used
in conjunction with websites
Your password is used in conjunction with your username and should be kept a secret
A web design language which enables web pages to communicate with a database
A free tool, which has been developed to hand the administration of a MySQL
database
The question asked of the data within a database, allowing the user to search through
the records.
All the data stored about a single person i.e. staff member or thing i.e. fixture
Pages within the site, where content does not change
Enables every record within the database to be uniquely identified and is also known
as a primary key
This identifies you to the system and with a correct password, access is granted
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Troubleshooting Guide
Problem
I can’t log in and am displayed with the following
message:

Solution
Please check your username and password are
being entered correctly
Do you have CAPS LOCK on?
If you are still unable to access the system, please
consult a member of the ICT technical team

I keep seeing the following screen when trying to
add, search or delete a fixture:

You are not logged into the system
Please return to the login screen and enter your
username and password
When you are logged in, try to access the page again

I have submitted a fixture in error

You can simply go to the delete fixture page, find
the fixture you have just submitted and note down
the ID number
Type the ID number into the delete box and press
the submit button

The sport I need is not listed

The fixture will be deleted from the database
Speak to a member of the ICT technical team who
will be able to add the sport to the drop down list(s)

The staff member I need is not listed

The lists on the public search page, staff search page
and new fixture page will need to be updated.
Speak to a member of the ICT technical team who
will be able to add the staff member to the drop
down list(s) for you.

I have forgotten my username/password

The search I performed displayed 0 results

The lists on the staff search page and new fixture
page will need to be updated.
Please consult a member of the ICT technical team,
who will be able to tell you your username or reset
your password for you
Try amending the search criteria you have used

30

Try using alternative keywords or just part of the
search term
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